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1. Terminologia e simbologia della guida 
1.1.1.  
1.1.2. Invio/Enter: Inv 

1.1.3. Mouse tasto destro e sinistro: MsDx, MsSx; 
1.1.4. Tasto Control: Ctrl; 
1.1.5. Tasto generico: Tasto;  
1.1.6. Tasto Shift: Shft 
1.1.7.  

2. Premesse 

2.1. Idioma 

2.1.1. Il presente manuale è specifico per la versione in italiano 

2.2. Legami con la versione inglese 

2.2.1. Ovviamente la versione inglese è quella originale. Si osserva che mentre nei 
menu a tendina e nelle barre degli strumenti i comandi nelle varie lingue sono gestiti 
in modo analogo e quindi è facile trovare le corrispondenze, non si può dire lo stesso 
per i comandi ACL che in generale sono diversi. 
Il problema sussiste per esempio negli script (Autolisp. Diesel etc), particolarmente 
quelli trovati su internet, dove sono riportati i comandi in inglese e che quindi non 
funzionano se lanciati da AU in Italiano. Per renderli operativi occorre trovare i 
corrispondenti. Una soluzione che si può provare, oltre all’help in linea, è aggiungere 
un underscore ( _ ) come primo carattere al corrispondente inglese. 
 

3. Sistema di coordinate 

3.1. WCS e UCS 

3.1.1. WCS è il sistema assoluto (globale) di riferimento tridimensionale. UCS 
invece rappresenta un sistema di riferimento fissato dall’utente. Coerentemente W sta 
per World (anche indicato come G = global), U sta per User; 
 

4. Metodi  per la creazione di immagini 3D  

4.1. Generalità 

4.1.1. Si può operare essenzialmente in 3 modalità: 
1) metodo modelli wire frame 
2) metodo dell’UCS detto della modellazione di superficie 
3) metodo della modellazione solida 

4.2. Modelli wireframe 
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4.2.1. Con i modelli wireframe si costruiscono dei telai tridimensionali costituiti da 
linee di volume e massa nulla. Si tratta quindi di ‘scheletri’ che non potranno mai 
generare ombre ne nascondere oggetti disposti dietro. Un metodo di operare può 
essere quello di costruire modelli wireframe e quindi sfruttarlo per generare sopra di 
esso superfici.  

4.3. Modellazione solida 

4.3.1.  
Crea volumi dotati di massa, è possibile determinare baricentri o altre grandezze 
relazionate ad un corpo solido. 
 

4.4. Modellazione superfici 

4.4.1. Non opera su volumi e quindi su solidi ma su superfici. Non si dispone quindi 
su alcuna informazione su baricentri, massa etc. Utilizza esclusivamente tecniche 
bidimensionali, crea dei cosiddetti frame che costituiscono la base per costruire 
oggetti wireframe.  
4.4.2.  

5. Creiamo i primi oggetti tridimensionali 

5.1. Un primo orientamento nel 3D 

5.1.1. Sistemi di riferimento e viste 
La prima fase di orientamento può porsi come obiettivo il sapersi orientare fra i 
concetti di sistema di riferimento assoluto WCS, relativo (chiamato utente in 
autocad) UCS e di vista. 
La prima osservazione fondamentale è che quando si ragiona in termine di 
sistemi di riferimento si pone l’attenzione sulla costruzione del disegno e non su 
come lo si vede. Viceversa per quanto riguarda le viste.  

5.1.2. Viste di un cubo nello spazio 
Come primo esempio esplicativo si opera su una figura molto semplice: il cubo. 
Si apra il disegno cubo.dwg. Si confronti per orientarsi la proiezione ortogonale 
complessiva e il disegno 3D. Si precisa che  di base il sud nel bidimensionale si 
colloca verso il basso schermo, il nord verso l’alto, l’ovest a sx e l’est a dx. 
Rifacendosi quindi a quanto detto nel paragrafo precedente si può osservare  
che è guardare un disegno dalla direzione Sud-Ovest e vederlo sviluppare in 
riferimento a un UCS posto a Nord. 

5.2. Creazione di viste e richiamo 

5.2.1. Viste assonometriche 
Lo sviluppo del disegno in AU viene eseguito tramite viste assonometriche, vale 
a dire senza tener conto della distanza che viene assunta come infinita. 

5.2.2.  Posizionamento punto di vista 
In AU2000 l’individuazione del punto di vista può essere utilmente eseguita con il 
comando Visualizza  ⇒  Punti di vista 3D   ⇒  Ruota il punto di vista. L’impostazione è 
quella di servirsi di una sorta di doppio goniometro: la prima parte (a sinistra) 
posto sul piano orizzontale, la seconda (a destra) posto sul piano verticale. Il 
sistema di riferimento è quello cartesiano con le convenzioni internazionali, per 
cui, per esempio, la rotazione e l’angolo positivo sul piano xy è misurata in senso 
antiorario e a partire dall’asse delle x. 
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5.2.3. I valori dei due angoli possono essere fissati graficamente ciccando sulla 
raggiera del goniometro, oppure digitati manualmente sotto le figure.Metodo 
della bussola 

5.2.4. Assegnare un nome ad una vista 
Per creare una vista è sufficiente definirla e quindi in Vista con nome ⇒ Nuova 
salvarla con un nome che sia il più possibile identificativo. Si osserva che in 
AU2000 è possibile associare alla vista anche l’UCS.  

5.2.5. Richiamo di una vista 
Visualizza ⇒ Vista con nome; 

5.3. Creazione degli UCS 

5.3.1. Premessa 
è opportuno crearsi un set, o più set, di UCS standard che possano essere 
utilizzati in più disegni. Per esempio gli UCS Nord, Sud, Est, Ovest, Sopra, Sotto 
sono UCS che tornano quasi sempre utili. Si può creare un disegno di ambiente 
che contenga anche gli UCS predisposti. 

5.3.2. Creare un UCS con tre punti 
Occorre dapprima disporre di tre punti che, assieme all’origine definiscono i tre 
assi cartesiani.  
Pensiamo per ora  a come creare gli UCS cartesiani fondamentali. Un metodo 
semplice consiste nell’imporre un’altezza ad una linea , trasformandola in una 
linea solida tramite Edita ⇒ Proprietà ⇒ Altezza. La linea acquisisce la 
caratteristica di una superficie e quindi dispone di quattro punti, sufficienti per 
generare l’UCS. Si andrà in Strumenti ⇒ Nuovo UCS ⇒ 3 punti.. Si può assegnare 
un nome all’UCS tramite Strumenti ⇒ altri UCS quindi selezionare con MsDx 
rinominare l’UCS. 

5.3.3. Richiamo degli UCS Strumenti ⇒ altri UCS ⇒ si imposta l’UCS corrente. 

5.4. Viste ed UCS 

5.4.1. Problematica 
Nel disegno tridimensionale occorre saper relazionare opportunamente UCS e 
viste in modo che il punto di riferimento della costruzione del disegno e come se 
ne vede lo sviluppo siano armonizzati. 

5.4.2. Associare una vista ad un UCS 
Punti di vista 3D ⇒ Vista piana  ⇒ Altri UCS e quindi digitare il nome dell’UCS 
associato alla vista. AU si porrà di fronte al piano XY della vista indicata. 

5.5. Operazioni di editing 3D 

5.5.1. Rotazioni 
La rotazione di oggetti può essere effettuata direttamente rispetto ad un asse 
dell’UCS, oppure rispetto ad un asse definito tramite due punti nello spazio. 
L’accesso al comando è Edita   ⇒  Operazioni 3D  ⇒  Ruota 3 D.  
E’ opportuno ricordare che l’unità di misura della rotazione è controllata da 
AUNITS (il valore di defual è 0 che corrisponde a gradi, 3 è radianti, 2 gradi 
centesimali). 
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5.5.2. Rotazioni che si servono del comando Ruota (2D) 
Si osserva che si può anche procedere con il normale comando Ruota. Occorre 
però sempre disporsi in modo che la rotazione avvenga rispetto all’asse z 
dell’UCS corrente. Normalmente, con questo sistema, si procede creando un 
UCS tramite tre punti e collocandolo perpendicolarmente (piano xy) all’asse in 
cui avviene la rotazione. 

5.5.3. Specchio 3D 
Consente di effettuare una copia speculare nello spazio. L’accesso è Edita   ⇒  
Operazioni 3D  ⇒  Specchia 3 D.   

5.6. Creazione di facce 3D 

5.6.1. cosa sono 
Si tratta di superfici piane solide che possono essere definite da tre o quattro 
punti. Poiché sono solide coprono gli spigoli da esse nascoste. 

5.6.2. Come si creano 
Si utilizza il comando in Disegna/Superfici/ Faccia3D che richiede appunto di 
selezionare i punti che definiscono la superficie. Talvolta è utile nascondere gli 
spigoli in modo da ottenere l’unione apparente di più facce in una. Il metodo più 
rapido è selezionare la faccia ed andare in proprietà e deselezionare la visibilità 
per ciascun spigolo. 

5.6.3. Creare facce con PFACE 
PFACE ( _PFACE in ITA) consente di creare facce con bordi invisibili indicando 
una serie di punti consecutivi. La sequenza di input si divide in due parti, la prima 
individuando i punti (1..n) e confermando (possibilmente in una sequenza 
ordinata per la generazione delle facce), quindi, sapendo che AU ha assegnato 
un numero crescente a ciascuno dei punti indicati, dare appunto la successione 
dei numeri identificativi dei vertici, in generale 1..n .    

5.6.4. Rendere i bordi invisibili in modo permanente 
Esiste una utilità in lisp Edge che rende invisibili i bordi in modo definitivo. E’ 
sufficiente richiamarla e selezionare i bordi in sequenza. L’operazione è tuttavia 
possibile se i bordi invisibili sono selezionabili, cosa che nella modalità normale 
di visualizzazione non è possibile; occorre quindi prima selezionare l’opzione 
Visualizza attivando Tutto o Spigolo per rendere individuabili gli spigoli. Ovviamente 
nel primo caso rende individuabili tutti gli spigoli del disegno. 

5.6.5. Selezionare facce 3D 
Le facce 3D sono di facile selezione se gli spigoli sono visibili. Il suggerimento è, 
nelle varie operazioni di copia, sposta etc., di rendere visibile almeno uno spigolo 
di una faccia con Edge, utilizzandolo per l’operazione; si può procedere, come 
metodo, ponendo come ultima operazione l’assegnazione di invisibilità alle 
facce.      

5.7. Creazione di superfici con l’altezza e la larghezza 

5.7.1. Altezza e larghezza 
In AU è possibile assegnare a linee e polilinee un’altezza e, solo per le polilinee, 
una larghezza. Ciascuna aggiunta determina l’aumento di una dimensione, 
quantomeno dal punto di vista della visualizzazione perché di fatto si rimane 
all’interno della modellazione per superfici. 
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5.7.2. Assegnazione altezza 
L’altezza fa riferimento all’asse Z all’atto della creazione dell’oggetto. Cambiando 
poi gli UCS non viene perduta la direzione iniziale. Per ottenere il risultato si può 
accedere in proprietà. 

5.7.3. Assegnazione larghezza ad una polilinea 
Ad una polilinea è possibile assegnare una larghezza iniziale e finale del primo 
segmento indicato nella polilinea, semplicemente agendo in proprietà. Se poi si 
assegna un valore all’altezza globale, tale valore verrà assegnato a tutti i 
segmenti della polilinea.          

5.8. Modifica delle superfici (mesh) 

5.8.1. Cosa si può modificare 
Essenzialmente le modifiche apportabili alle superfici in AU sono nei termini di 
spostamenti di vertici. Non si riescono ad applicare invece comandi come 
Raccorda o Cima, oppure utilizzando intersezioni di superfici. Si tratta quindi di 
interventi limitati. 

5.8.2. Come si opera 
Poiché AU considera le superfici come varianti di polilinee, il comando da 
utilizzare è Edita Polilinea. La superficie o mesh dovrà essere selezionata e all’atto 
dell’operazione di editor dei vertici verrà visualizzata una crocetta, indicante 
appunto il vertice attivo. Utilizzando le opzioni sopra, sotto, sinistra etc, si potrà 
araggiungere qualunque vertice (con una certa lentezza) e quindi con l’opzione 
SP spostarlo. Si osserva che gli spostamenti con coincidono con i riferimenti 
cardinali delle viste ma semplicemente come la superficie viene costruita. 
Altra opportunità è l’utilizzo delle Grip o maniglie. Quando si seleziona una 
superficie appaiono tutti i vertici, selezionandoli con il mouse, insistendo sul 
punto, il vertice diventa giallo, quindi sarà sufficiente spostarlo. 

5.8.3. Leviga superfici 
Si tratta di un comando, o meglio di un’opzione di Edita polilinea applicata alle 
superfici, che consente di creare una superficie dall’approssimazione di una 
superficie esistente. Per certi versi ha una funzione simile all’opzione Spline, 
sempre in Edita polilinea nelle operazioni 2D.    Le variabili di controllo 
dell’operazione di levigatura sono 3: 
Surftype: 1= quadriga; 2=cubica; 3=bezier 
Surfu: regola la definizione della superficie generata nella direzione M (2-200), 
default 6 
Surfv: regola la definizione della superficie generata nella direzione N (2-200), 
default 6 
Il massimo arrotondamento e di flessibilità della curva la si raggiunge con 
l’opzione Bezier, sarà anche la superficie più lontana dall’originale. Le variabili 
Surfu, connesse a suftype, determinano la densità di mesh nelle due direzioni di 
generazione della superficie. 
                                                                                                                                                   
 
 

5.9. Schermi multipli 
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5.9.1. Finestre multiple 
Si accede tramite Visualizza/Finestre/Nuove finestre. Si sceglie quindi così la 
suddivisione dello schermo in più viste attivabili fra quelle esposte. Si tratta di 
finestre finalizzate alla costruzione del disegno ed indipendenti fra loro. 

5.9.2. Modello e layout 
E’ importante ricordare che lo spazio modello è adatto alla costruzione del 
disegno mentre lo spazio layout è adatto alla stampa. Si tratta di una soluzione 
che sostituisce lo spazio carta utilizzato nell’AU14. Indicazioni e nuovi oggetti 
costruiti nel layout vengono considerati elementi descrittivi della stampa e quindi 
non vengono poi riportati nello spazio modello. 
 

5.10. Prospettive 

5.10.1. Di cosa si tratta 
Le viste assonometriche utilizzano linee parallele e non relazionano la profondità 
con l’effetto distanza. Per ottenere una visione reale di un oggetto, così come lo 
può vedere un occhio, è necessario utilizzare viste prospettiche. 
Occorre ragionare come se si utilizzasse una macchia fotografica (camera). 
Quando si effettua una fotografia esiste: 
- un punto di mira: centro del mirino della camera, ovvero il punto osservato 
- un punto di vista: posizione dell’occhio del fotografo 
- una distanza: distanza fra il punto di vista e il punto di mira 
Si osserva che il centro del mirino della macchina fotografica individua una retta 
e non un punto. Diventa un punto nel momento in cui è fissata la distanza. 
 

5.10.2. Come si creano 
In AU2000 la funzione per viste prospettiche è Visualizza ⇒ orbita3D.. Una volta 
richiamata, con MsDx è possibile attivare una serie di funzioni interne ad 
Orbita3D. 
  
Altre opzioni: 
PAn: consente di ingrandire o rimpicciolire l’immagine con la stessa tecnica della 
distanza focale di un obiettivo. 
CAmera: consente una regolazione dell’altezza rispetto al “suolo”, ovvero 
l’altezza del punto di vista. 
Twist: consente di correggere l’inclinazione dell’apparecchio. 
 

6. Superfici tridimensionali 

6.1. Facce 

6.1.1. Cos’è una faccia 
E’ una superficie piana rettangolare (4 lati) o triangolare (3lati). 

6.1.2. Come si crea 
Il comando specifico è Faccia3D. Una volta attivato richiede i tre o i quattro punti 
che descrivono la faccia. Se ad ogni indicazione del punto si precede digitando ‘i’ 
gli spigoli della faccia diventano nascosti, altrimenti saranno visibili. Comunque è 
possibile poi in proprietà cambiare scelta.  
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6.2. Superfici di rivoluzione 

6.2.1. Cosa si intende 
si tratta di superfici generata da una rotazione di un profilo lineare attorno ad un 
asse. 

6.2.2. Come si ottengono 
Si crea prima la curva base bidimensionale e l’asse attorno a cui deve ruotare. A 
questo punto si richiama il comando Superficie di rivoluzione (meglio nella barra 
degli strumenti) e si procede fissando anche gli angoli. E’ opportuno, prima di 
cominciare fissare SURFTAB1 e SURFTAB2 che controllano la densità della 
mesh, rispettivamente di rivoluzione e attorno alla linea base. 
Si possono ruotare: linee singole, polilinee, spline. Ricordiamo che esiste 
l’opportiunità di trasformare una polilinea in una spline approssimata. 

 
6.2.3. Creazione di polilinee 

In generale, la creazione di superfici chiuse richiede curve base che vanno poi 
relazionate ad altre curve o a assi di rotazione o a vettori. Una curva complessa 
può essere realizzata tramite una Spline, soluzione che però non sempre è 
ottimale in quanto la sua definizione risulta da una interpolazione di punti. In 
molti casi sarebbe utile riferirsi a profili che sono insiemi di archi di cerchio e 
segmenti, occorre però che siano un'unica entità per inserirli nella creazione di 
superfici. In AU la soluzione consiste nel servirsi di polilinee. Si crea appunto il 
profilo di archi e segmenti (che devono essere uniti) quindi si richiama il 
comando Editpl (Edita ⇒ Oggetto ⇒ Polilinea) si seleziona uno dei segmenti 
costituenti, trasformandolo in polilinea, quindi con l’opzione Unisci si selezionano 
tutti i restanti creando quindi un unico oggetto.  
Attenzione: qualora si intende utilizzare una polilinea chiusa come primitiva per 
generare superfici o regioni è sempre opportuno chiuderla con  Edit ⇒ Polilinea ⇒ 
Chiudi, lasciando, in altre parole ad AU la chiusura corretta della linea. In alcuni 
casi infatti si sono riscontrati errori di generazione senza seguire questa strada. 
In Edit ⇒ Polilinea ⇒ Larghezza è possibile anche definire una larghezza di linea, 
utile per generare spessori. Si nota che la larghezza è la misura ortogonale 
all’altezza che può essere assegnata in Edit ⇒ Proprietà. 

6.2.4. Superficie estrusa 
E’ generata da due elementi: curva base e vettore direzione (segmento). La 
curva base si muoverà nello spazio seguendo il vettore direzione per tutta la sua 
lunghezza e generando appunto il solido. Il vettore direzione è individuato dal 
segmento congiungente il primo e l’ultimo punto della curva. 

6.2.5. Superficie rigata (Rulesurf) 
Si genera con due curve base. Autocad  in base alla definizione del wire divide le 
due curve in un numero uguale di punti e li congiunge con rette. 

6.2.6. Superficie di bordo 
A partire da quattro curve che si intersecano autocad genera una superficie  
cosiddetta di bordo. Le quattro curve possono essere: linee ma non insieme di 
linee, polilinee, spline create direttamente o spline create da polilinee 

7. Altre operazioni di editing 3D 

7.1. Allineare forme tridimensionali nello spazio 
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7.1.1. A cosa serve 
Spesso si verifica il problema di collocare un oggetto nello spazio, facendolo 
appoggiare ad un piano o comunque allineare rispetto a dei punti. Si può 
utilizzare il comando Allinea, che può anche, contemporaneamente effettuare 
operazioni di scala. 

7.1.2. Come si procede 
Si chiama il comando Allinea, che consente di spostare due o tre punti 
dell’oggetto (origine), in due o tre punti di destinazione. Il terzo punto di 
destinazione definisce il piano nel quale i tre punti origine andranno a collocarsi; 
qualora si imponga un’operazione di scala, determinerà anche un 
ridimensionamento dell’oggetto che si otterrà immaginando che il segmento dato 
dai due punti origine si espanda in modo da appoggiarsi esattamente sui punti 
destinazione. 
Il comando può anche essere utilizzato per generare nuovi oggetti a partire da 
uno origine. Si può utilizzare a questo proposito il trucco di una copia dell’oggetto 
origine sui su se stesso. 

 

8. Ombreggiatura 

8.1. Applicabilità 

8.1.1. Consente di visualizzare il disegno 3D nascondendo le superfici nascoste e 
creando un ombreggiatura che aiuta nella comprensione del disegno. Non è una 
visualizzazione precisa come il rendering ma è più veloce inoltre consente la 
rotazione dell’oggetto nello spazio mantenendo l’ombreggiatura tramite Orbita 3D. 

8.2. Come si applica 

8.2.1. L’accesso è in Visualizza ⇒ Ombra  ⇒ si accede alle varie opzioni. Per 
vedere le superfici definite occorre andare sull’ombra piatta o di Gouraud (più rifinita 
rispetto alla piatta) 

8.3. Orbita 3D 

8.3.1. Consente di ruotare una figura ombreggiata senza uscire in assonometria. 
Ala vista appare un cerchio con impressi quattro punti cardine, due laterali (sinistra e 
destra), due verticali (sopra e sotto). I punti laterali trascinandoli consentono una 
rotazione orizzontale rispetto ad un asse verticale rispetto al punto di vista corrente 
dell’osservatore; i punti verticali consentono una rotazione rispetto ad un asse 
orizzontale. 

8.4. Altre opzioni di movimentazione 3D 

8.4.1. Con Msdx è possibile attivare una serie di modalità di movimentazione 
dell’oggetto nello spazio. 
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9. Modellazione solida (MS) 

9.1. Preparazione ambiente e concetti di base 

9.1.1. Barre degli strumenti 
E’ opportuno aggiungere la barra Solidi e la barra Modifica 2 , la prima consente di 
generare le primitive solide, la seconda consente operazioni di edit sui solidi 

9.1.2. Operazioni Booleane 
Si tratta delle operazioni fondamentali che si eseguono con i solidi: 
- UNIONE 
- SOTTRAZIONE 
- INTERSEZIONE 

9.1.3. Variabili di visualizzazione 
9.1.3.1. Facetres 

La variabile Facetres regola la levigatezza degli oggetti ombreggiati e 
sottoposti a rendering. Varia fra 0.1 e 10 

9.1.3.2. Isolines 
Controlla la precisione della mesh che descrive il solido generato 

9.2. Oggetti utili alla generazione di solidi 

9.2.1. A differenza della modellazione per superfici un oggetto solido si può 
ottenere per rivoluzione di una superficie piana e non una linea. Una linea può essere 
invece il vettore che definisce un percorso di estrusione, o una polilinea se il percorso 
è curvo. Per le linee di generazione occorre invece servirsi di polilinee chiuse. 

9.3. Estrudere una primitiva 

9.3.1. Oggetti che possono essere estrusi nella modellazione solida 
Autocad accetta estrusioni di Polilinee, Regioni, Spline. In ogni caso si deve 
trattare di contorni chiusi. Una regione può essere costituita da un misto di 
polilinee e spline. 

9.3.2. Polilinee di generazione 
Come si è anticipato nella MS non si possono estrudere polilinee aperte, devono 
essere chiuse. Il risultato può essere ottenuto tramite Edita Polinea (in Modifica 2) 
con Unisci applicato su un percorso chiuso. 

9.3.3. Estrusione della polilinea 
Si deve richiamare il comando Estrudi ⇒ si seleziona la polilinea creata e un 
percorso di estrusione che deve essere già presente, oppure un’altezza di 
estrusione . E’ possibile indicare un angolo di rastremazione che impone una 
certa conicità nel processo di  

9.3.4. Estrusione di una spline 
occorre creare un spline chiusa (ozione chiudi nel relativo comando). I contorni 
ottenuti in questo modo non sono oggetto dell’operazione di rastremazione. 

9.4. Regioni 

9.4.1. Cosa sono 
Si tratta di aree chiuse composte da linee, polilinee, spline, archi, le quali 
possono essere utilizzate come primitive nella generazione di solidi. 
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9.4.2. Come si creano 
Occorre creare un contorno chiuso senza intersezioni . Quindi tramite disegna ⇒ 
regione si procede alla creazione. Successivamente la regione può essere 
soggetta a rivoluzione o estrusione. 

9.5. Unire, sottrarre solidi 

9.5.1. come si procede 
Si accede alla barra Modifica 2, quindi si selezionano i rispettivi comandi. Si 
individua una differenza procedurale. Con unisci occorre selezionare di seguito i 
solidi da unire, quindi si conferma. Nel sottrarre invece si seleziona il solido da 
cui si sottrarrà materia, lo si conferma, quindi si indicano i solidi che sottraggono. 

9.6. Eliminare l’intersezione di due solidi 

9.6.1. Spesso capita di dover eliminare l’intersezione di due solidi, si pensi per 
esempio ad una piastra saldata  lateralmente a un cilindro. Il metodo più semplice è 
creare la piastra a forma di parallelepipedo, inserirla nel cilindro ed eliminare 
l’intersezione. Si può procedere creando i due solidi e sovrapporli, quindi generare 
una copia identica ed usarla per creare con Intersezione la parte che deve essere 
sottratta. Si tratta quindi di effettuare una sottrazione di solidi ottenendo il risultato 
cercato. 

10. Ritoccare i di solidi e sezionarli 

10.1. Cimare e arrotondare un solido 

10.1.1. Approccio generale 
Generalmente nel generare solidi ci si dimentica inizialmente delle operazioni di 
arrotondamento e cimatura. Solo in un secondo tempo si agisce sul solido già 
creato. 

10.1.2. Come si procede per cimare 
Si seleziona il comando cima così come si fa per il 2D, quindi AU chiederà si 
selezionare la prima linea. Si osserva che per i solidi la linea deve essere in 
realtà una superficie. Il concetto quindi è quello di selezionare una linea che 
identifichi una superficie. Poiché spesso una linea è uno spigolo e identifica più 
superfici, con l’opzione Seguente è possibile scorrerle fino a selezionare la 
desiderata. Quindi si dovranno indicare le due misure ortogonali della cimatura e 
infine selezionare tutte le line della superficie per cui si vuole confermare 
l’operazione. 

10.1.3. Come si procede per arrotondare 
 L’operazione di raccordare spigoli tridimensionali differisce sostanzialmente dal 
modo di operare 2D. Innanzitutto occorre che preventivamente i due solidi che si 
appoggiano allo spigolo siano uniti in un unico solido. Qualora siano due solidi 
appoggiati fra loro AU raccorda solo uno dei due. Richiamando il comando si 
deve inserire il valore corretto del raggio, quindi richiamare il comando. 
A questo punto AU chiede di selezionare uno spigolo. Se si tratta di uno spigolo 
3D AU chiederà di confermare il raggio, quindi chiederà di selezionare uno 
spigolo successivo con l’opzione Sequenza. L’utente dovrà comunicare la 
sequenza di spigoli dove sarà applicato il raccordo; se si tratta di un cerchio 
basterà la prima selezione. 
La successiva conferma (opzione Spigoli di default) comporterà la realizzazione 
del raccordo.  
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10.2. Modificare i solidi 

10.2.1. Comando Modifsolidi 
Comando ACL che richiama l’insieme di comandi di modifica solidi 

10.2.2. Opzione faccia 
Consente di accede a una serie di comandi che operano sulle facce di un solido. 

10.2.2.1. Estrudi 
Estrude una faccia di un solido lungo un vettore. La faccia traslando aggiunge 
materiale al solido. 

10.2.3. opzione Corpo 
Consente di accedere ad una serie di opzioni che analizziamo singolarmente. 

10.2.4. Comando Svuota:  
comando che crea una cavità all’interno del solido. La forma del solido sottratto 
all’interno è identica al solido originale, le sue dimensioni sono però ridotte, come 
a seguito di un’operazione di scala e in modo che le pareti esterne traslino si 
interno di un valore detto di sfalsamento.  

10.2.5. Impronta 
Consente di creare un’impronta di una figura 2D o 3D su un solido. L’effetto è 
una effettiva separazione superficiale sul solido lungo il profilo dell’impronta. Se 
poi, sulla faccia oggetto dell’impronta si effettua un’estrusione (solo con Estrudi 
Faccia e non con l’estrudi solidi), la parte racchiusa dall’impronta stessa non si 
estrude, viceversa se l’impronta individua una superficie che viene selezionata 
per l’estrusione, solo quella parte verrà estrusa.  
Si osserva che si possono estrudere solo facce piane, per altri tipi di facce AU 
segnala errore. Si possono ottenere impronte da regioni anche contenenti spline, 
solidi, oltrechè figure piane. 

10.2.6. Rastremazione facce 
La rastremazione faccia consente di inclinare le facce rispetto ad una direzione 
che è data da due punti. Per esempio se la si applica ad un cilindro, se la 
direzione è parallela all’asse, si ottiene un cono. 

10.3. Sezionare un solido e affettarlo 

10.3.1.  
10.3.2. A cosa serve 

Sezione è un comando che si prefigge di vedere com’è un solido lungo un piano, 
detto appunto di sezione. Si ottiene quindi un disegno 2D. Lo scopo non è quindi 
di creare degli spaccati, compito assegnato alla funzione Trancia 

10.3.3. Come si procede per sezionare 
L’operazione è abbastanza semplice. Occorre richiamare il comando (barra 
solidi), quindi o si indicano tre punti che identificano il piano di sezione oppure si 
seleziona la coppia di assi che identificano il piano, infine si seleziona il punto di 
passaggio del piano. 

10.3.4. Superficie di sezione 
La superficie di sezione è a tutti gli effetti una superficie utilizzabile per qualsiasi 
scopo, compresa la possibilità di costruire altri solidi.  
Per tratteggiarlo occorre porsi su un UCS che sta sulla superficie di sezione, 
quindi lanciare il comando relativo. 

10.3.5. Affettare un solido con Trancia (Slice) 
Occorre selezionare il comando 



Ing. Unterholzner approfondimenti autocad Data ultima stampa 19/03/2009 19.47.00 pag. 13 

 

 
 

11. Operare con le facce 

11.1. Concetti generali 

11.1.1. AU interpreta come facce le superfici piane che delimitano esternamente i 
solidi. Tramite le facce è possibile effettuare operazioni che si prefiggono obiettivi 
diversi, dalla creazione di solidi a ritocchi delle caratteristiche delle facce stesse. 
Per operare è opportuno attivare la barra degli strumenti Modifica solidi. 

11.2. Creazione di solidi tramite operazioni sulle facce 

11.2.1. Estrusione di facce 
Occorre selezionare il comando Estrudi facce, da non confondere con l’analogo 
(stessa icona) Estrudi, quindi, una volta selezionate le facce, procedere con 
l’estrusione con le consuete modalità. È da osservare che selezionando un linea 
è possibile che AU individui più facce. In tal caso con l’opzione Rimuovi occorre 
selezionare una linea che individui senza dubbi le facce da escludere dalla 
selezione. 

11.2.2. Estrusione di facce lungo traiettorie 
Si tratta di un’operazione che consente estrusioni complesse lungo traiettorie 
curve. 

11.3. Ottenere viste di solidi (layout di stampa) 

11.3.1. A cosa serve 
Nel disegno 3D occorre spesso ricavare, oltre che delle sezioni, anche viste 
ortogonali o poste su angoli decisi dal disegnatore, soprattutto se l’obiettivo è la 
stampa. AU dispone di strumenti che facilitano l’operazione. 

11.3.2. Come si procede 
Un metodo prevede la creazione di un nuovo layout dove si dovrà scegliere il 
formato del foglio oltreché la stampante. A questo punto si può decidere se 
eliminare la vista corrente allo scopo di crearne una nuova personalizzata, 
operazione che si deve fare se si vogliono viste ortogonali. 
Si chiama il comando Imposta vista  (Solview) e si sceglie l’opzione UCS come 
partenza. AU chiederà la scala e dov’è il centro della vista. Quest’ultima fase 
serve per individuare bene quale parte del disegno deve essere oggetto della 
vista (spostando il centro si riesce a far scorrere il disegno). Infine definendo la 
finestra si seleziona l’area che occuperà effettivamente la vista a cui si dovrà 
dare un nome. Con l’opzione Orto si possono creare altre viste. Quando chiede: 
specificare la parte della finestra da proiettare, occorre fare click sul lato (proprio 
lungo il bordo) della vista da cui si crea la nuova vista. 
Infine si deve completare l’operazione chiamando il comando Soldraw che 
realizza effettivamente le viste impostate. 
Nella generazione vengono creati dei nuovi layer che sotto vengono riportati: 
Nome vista-VIS Linee visibili 
Nome vista-HID Linee nascoste 
Nome vista-DIM  Quote 
Nome vista-HAT  Modelli di tratteggio (per le sezioni) 
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11.3.3. Posizionamento delle viste realizzate con Soldraw 
Quando si lancia il comando Soldraw viene generato un disegno bidimensionale 
che è parte integrante anche del modello.  Se la vista è stata fatta con l’opzione 
UCS il disegno sarà collocato nel piano XY dello stesso UCS con Z=0. Con 
l’opzione Orto il risultato sarà simile con il disegno posto per esempio nel 
pianoYZ e X posto a zero. 

11.3.4. Altre viste con Solview 
L’opzione UCS risulta particolarmente utile per creare la prima vista. Per le viste 
successive ci si può servire ancora dell’opzione UCS a patto di disporne già pronti 
e collocati nella posizione desiderata. In alternativa si può richiamare l’opzione 
Orto che consente di ottenere facilmente viste ortogonali a partire da viste 
esistenti. Si deve prima selezionare la vista esistente da cui partire, quindi 
selezionare un punto medio su uno dei quattro lati del contorno della vista per 
individuare da dove si guarda, infine un punto nel disegno, tramite uno snap, per 
indicare che cosa si guarda, il resto segue la stessa procedura. Si è ottenuta una 
vista ortogonale alla vista di partenza. L’opzione Sezione consente di ottenere 
sezioni in un layer con suffisso HAT su una vista esistente definendo il piano di 
sezione tramite due punti. E’ importante ricordare che il modello del tratteggio 
che viene selezionato non è detto sia quello desiderato. Si può andare in 
proprietà e correggere. 
L’opzione Ausiliario consente di creare delle viste su piani inclinati. 

11.3.5. Come configurare le viste ottenute 
Le viste ottenute possono essere ridimensionate con il metodo grip, quindi 
semplicemente selezionando gli angoli del rettangolo e trascinando. Per 
spostare la vista si può utilizzare Msdx sulla vista e selezionare Sposta. 

11.3.6. Quota 
Una volta ottenute le proiezioni si deve procedere a quotare. Si osserva che le 
proiezioni sono visibili anche nel modello. Si può procede a quotare tenendo 
presente un’importante differenza fra due possibilità: 
- finestra attiva (con riquadro annerito e spesso): in tal caso le quote apportate 
compariranno nello spazio modello.  
- finestra non attiva (riquadro sottile): in tal caso le quote appartengono solo allo 
spazio carta; si deve pensare che l’applicazione è fatta dall’esterno del disegno. 
Lo si può capire meglio applicando uno zoom interno alla finestra: le quote 
esterne non subiscono variazioni. Si ricorda che per entrare nella finestra 
occorre fare un doppio click all’interno. 

11.3.7. Scala 
11.3.7.1. scala all’interno della vista 

le regole per la scala all’interno della vista sono le stesse che si applicano al 
disegno bidimensionale quando si utilizzano i layout nella costruzione delle 
finestre. Si veda quindi il manuale di autocad 2D alla voce Layout. 

11.3.7.2. Scala all’esterno della vista 
In tal caso ciò che fa testo è il foglio prescelto per il disegno. Per esempio se 
è un A3 dovrò rapportare le dimensioni del testo e delle quote al foglio A3. 
 

11.4. Interferenza e separazione 
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11.4.1. Interferenza 
Il comando che consente di accedere al calcolo delle interferenze è _interfere. Si 
tratta di un comando nato per individuare le compenetrazioni di solidi e quindi 
consentire all’utente di ricavare le opportuni conclusioni. AU consente tuttavia di 
utilizzarlo anche per la generazioni di solidi in quanto crea un solido di 
interferenza che può essere mantenuto. 

11.4.1.1. Come si procede 
AU chiede di individuare due gruppi di solidi e fra di questi genererà il solido di 
interferenza. 

11.4.2. Separazione di solidi 
11.4.2.1. A cosa serve 

Tramite unisci solidi è possibile unire solidi anche distanti, operazione utile 
quando, per esempio, si vuole spostare gruppi di solidi come un unico gruppo. 
Può essere utile poi separarli per svariate ragioni. 

11.4.2.2. Come si procede 
Si attiva l’opzione Separa in Modifica solidi ⇒ Corpo, oppure direttamente con 
_separate. Sarà sufficiente selezionare il solido composto da scomporre. Il 
comando non funziona per solidi che hanno parti comuni e quindi composti 
intimamente. 

 

12. Ambiente 

12.1. Cosa si intende 

12.1.1. Ci si riferisce a tutte quelle operazioni di configurazione che possono variare 
il modo di operare, sotto diversi punti di vista, per esempio: visualizzazione degli 
oggetti, rappresentazione degli spigoli e altre opzioni. 

12.2. Visualizzazione 

12.2.1. Sistema grafico 3D corrente 
Definisce la qualità delle rappresentazione visiva degli oggetti 3D 
Occorre andare in Strumenti ⇒ Opzioni ⇒ Sistema ⇒ Sistema grafico 3D corrente. Se 
si entra in proprietà è possibile definire e, in particolare, diminuire la qualità di 
rappresentazione avvantaggiandosi sulla velocità di visualizzazione. Per 
esempio selezionando Riduzione di qualità adattiva è possibile attivare una serie di 
opzioni di riduzione di qualità. 

12.2.2.  
12.2.3.  

13. Rendering 

13.1. Aggiunta di una scena 

13.2. Impostazione del rendering 
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13.2.1. Tipi di render 
AU prevede tre tipi di rendering 
- normale: non sopporta le ombre le bitmap 
- qualità fotografica: gestisce le ombre, le trasparenze 
-raytrace fotografico: si tratta dell’opzione più raffinata che si basa su un controllo 
effettivo del raggio luminoso e che quindi consente di considerare anche i riflessi 
e fenomeni di difrazione. Naturalmente è molto più lento. 

13.2.2. Ozioni del comando rendering 
Nella finestra del comando rendering si possono configurare molte opzioni. 
Indichiamo alcune di quelle più significative 
- Richiesta di selezione: consente un’applicazione del rendering ai soli oggetti 
selezionati 

13.2.3. altre opzioni 
E’ possibile settare varie configurazioni di rendering. Ne riportiamo alcune: 
- ombra piana: rende più lisce le superfici 
- destinazione: consente di trasferire il rendering su un file indipendente 

13.2.4. Anti-aliasing 
Normalmente curve e lineee inclinate assumono un aspetto frastagliato (aliasing) 
dovuto ad approssimazioni necessarie per una rapida visualizzazione degli 
oggetti. Si effettuano operazioni Anti-alising per ridurre questo genere di errore 
visivo. 
In AU andare in Rendering ⇒ Altre opzioni ⇒ Anti-aliasing  

13.2.5.  

13.3. salvare un’immagine rendering 

13.3.1. Una volta eseguito il rendering può essere utile salvare l’immagine. Questo 
può essere fatto accedendo a Strumenti ⇒ Immagine ⇒ Salva. Viene salvata la bitmap 
della finestra attiva. 
13.3.2.  

13.4. inserire luci 

13.4.1. A cosa serve 
con tutti i tipi di rendering è possibile visualizzare l’effetto di luci di diversa natura, 
creando ambienti in cui l’illuminazione è una componente determinante. 

13.4.2. Tipi di luci 
Si possono inserire tre tipi di luce. 

13.4.2.1. Luci puntiformi 
Simulano l’introduzione di un lume (o lampadina) all’interno di un ambiente, 
dove la luce si irradia in tutte le direzioni, diminuendo la propria influenza con 
la distanza dell’oggetto investito dai sui raggi 

13.4.2.2. Luci spotlight 
Si tratta di luci che generano coni luminosi. Occorre specificare la direzione 
della luce e l’estensione del cono. L'intensità delle spotlight diminuisce con 
l'aumentare della distanza. 
Il cono si divide in due coni concentrici: quello interno è il cono con luce 
brillante, quello esterno, detto di caduta, rappresenta lo spazio in cui la luce si 
attenua. 
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13.4.2.3. Luci distanti 
Si tratta di luci che investono tutti gli oggetti del disegno uniformemente e con 
raggi paralleli. 

13.5. Ombre 

13.5.1. Come si attivano 
Per ogni luce è possibile decidere se attivare l’ombra relativa. L’attivazione viene 
eseguita tramite un selettore nella definizione della luce (tasto Modifica). 
Occorre poi, nella finestra del rendering, nelle opzioni di rendering, attivare 
almeno una delle opzioni generali sulle ombre, Ombra piana e Ombre. 

13.5.2. Come ottenere ombre qualitative 
Quando nelle singole luci si attivano le ombre è opportuno entrare in Opzioni 
ombre e controllare che sia selezionato: Volumi delle ombre/ombre tracciate dai raggi.  
In tal caso si ottiene un effetto fotorealistico. Qualora l’opzione venga disattivata 
occorre configurare manualmente i parametri. Di base si ottengono ombre 
scadenti, se però uso valori alti per Dimensioni della mappa delle ombre, per esempio 
almeno 1024, e valori della Morbidezza intorno a 4, ottengo buoni risultati. La 
morbidezza è necessaria qualora non si vogliano mantenere ombre troppo nette 
e poco realistiche. 

13.6. Creazione di scene 

13.6.1. A cosa servono 
Si tratta di memorizzazioni di rendering che possono essere richiamate con un 
solo nome 

13.6.2. come si opera 
E’ sufficiente entrare nel comando Scene all’interno di Rendering e creare una 
scena nuova L’utilizzo è del tutto intuitivo. Il concetto consiste nell’associare ad 
una scena una vista a cui sia stato dato un nome in Viste con nome e quindi 
decidere quali luci associare a tale vista selezionandole. 

13.6.3.  

13.7. Applicare i materiali e sfondi 

13.7.1. A cosa serve 
si tratta di una funzione che attacca a delle superfici di solidi delle caratteristiche 
che simulano la presenza di materiali. 

13.7.2. Come si procede 
La procedura da seguire comprende alcuni passaggi fondamentali: 
- allegare materiali al disegno, in modo che siano a disposizione tramite Libreria 
materiali 
- attaccare i materiali alle superfici, tramite Materiali 
- visualizzare il risultato con Rendering applicando i due tipi di rendering: Qualità 
fotografica e Raytrace fotografico. 

13.7.3. Per sapere le associazioni fra oggetti e materiali 
Quando si è nella finestra materiali si selezione il materiale e premendo Attacca 
AU evidenzia gli oggetti a cui è stato applicato quel materiale. 
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13.7.4. Modifica dei materiali 
Entrando in Lista dei materiali che indica l’elenco dei materiali che possono essere 
associati al disegno (tramite il pulsante Importa) e quindi in Materiali è possibile 
procedere alla modifica delle caratteristiche dei materiali stessi 

13.7.4.1. Attributi 
La costruzione/modifica di un materiale passa per la definizione degli attributi. 
La gestione dei parametri è in generale molto intuitiva. 

13.7.4.1.1. Colori dei materiali 
Qualora un materiale non sia definito da un’immagine si possono 
attribuire dei colori. I colori sono di tre tipi: il colore proprio del materiale: 
Colore/modello, il colore che l’oggetto emette in risposta alla luce che lo 
investe: Ambiente ed infine il colore di riflessione, appunto Riflessione, che 
caratterizza la luce riflessa dall’oggetto. 

13.7.4.2. Regolazione della bitmap 
Per quei materiali che si basano su una o più bitmap si può entrare in Regola 
bitmap e configurarne l’uso. Si riportano alcuni parametri: 
-Scala fissa: la scala della bitmap è fissa e stabilita dai parametri U e V 
(guarda anche il sottoparagrafo Misure sotto riportato). L’opzione Adatta 
all’entità comporta di fatto un utilizzo delle opzioni di mappaggio (vedi dopo) 
per configurare l’orientamento della bitmap sull’oggetto; 
- Asse automatico: se selezionato Au sceglie come asse di riferimento un asse 
dell’oggetto (per esempio l’asse di un cilindro). Se l’opzione è deselezionata 
allora la bitmap viene proiettata comunque sul piano XY 

13.7.5. Applicare sfondi 
Si accede a Render ⇒ Sfondo quindi si decide se optare per dei colori o per altre 
soluzioni quali immagini. 

13.7.6. Creare materiali con misure controllate 
13.7.6.1. Creare materiali con immagini aster 

E’ possibile creare materiali basandosi su immagini raster. E’ sufficiente nella 
creazione del materiale andare su Trova file e quindi caricare l’immagine 

13.7.6.2. Misure 
Si può rilevare le misure in mm di un’immagine raster tramite un programma 
di grafica, anche il Paint di windows. Per calcolare la loro dimensione di 
renderizzazione occorre dividere tali misure per 100. Quindi, se per esempio 
la misura in mm rilevata è proprio quella che si vuole appaia nel disegno 
occorre in Regola Bitmap inserire nel campo Scala il valore di 100 sia su U che 
su V. 

13.8. Mappaggio dei materiali 

13.8.1. A cosa serve 
Risolve il problema dell’orientamento del rendering su di un oggetto. Per 
esempio se si deve rivestire una superficie inclinata occorre inclinare la 
disposizione del motivo (immagine) del rendering. Il 
posizionamento/orientamento del materiale diventa quindi indipendente dalla 
posizione dell’oggetto ma acquisisce un suo proprio orientamento. 

13.8.2. Criteri generali 
La mappatura dei materiali viene eseguita sugli oggetti e non sul materiale. 
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13.8.3. Come si procede 
Si attiva il comando Mappaggio dentro il menù rendering. Si sceglie quindi i tipo di 
proiezione. L’opzione Proiezione piana è compatibile alla Scala fissa (vedi prima) 
selezionata per il materiale. Tutte le altre proiezioni comportano la scelta 
dell’opzione Adatta all’entità. 

13.8.4. Proiezioni 
Quando si entra nell’area mappaggio viene chiesto quale tipo di proiezione si 
intende fare. La piana è una proiezione che non distorce l’oggetto. Le proiezioni 
cilindrica e sferica riportano la bitmap come se fosse appunto proiettata su un 
cilindro o una sfera. La proiezione piana funziona sia sui materiali standard che 
sui materiali 3D (legno, marmo etc). 
Se si entra in Regola coordinate è possibile riconfigurare la bitmap tramite Regola 
bitmap. Si osserva che il parametro scala va inteso come scala 1:X. Tanto più 
grande è x tanto più piccolo risulta la bitmap proiettata. 

13.8.4.1. Proiezioni non piane 
Si ottiene, in generale, una distorsione del materiale perché viene proiettato 
su cilindri o sfere 

13.8.4.2. Proiez. Sferica 
13.8.4.2.1. Punti di selezione 

Consentono di orientare la proiezione del materiale tramite snap. 
Occorre dare il punto centro della sfera, un punto che definisce il raggio 
della sfera e un punto:direzione di congiunzione che indica la direzione 
da dove si comincia ad applicare il materiale. Lungo quella direzione si 
vedrà la linea dove il materiale si ricongiungerà dopo aver fatto tutto il 
giro della sfera. 

13.8.5. Eliminare le opzioni di mappaggio 
Si può utilizzare il comando lisp:  (c:mappaggio "D" (ssget)) che chiederà di 
selezionare gli oggetti per cui si vuole eliminare il mappaggio. 


